
Important Dates:  

·  March  21, 2005: 
MasterTax Quarter-
End Web Seminar 

·  March 22, 2005:                   
1st Quarter 2005 
Release available 
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Our office will be 
closed in observance 
of  Memorial Day 
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MasterTax Announces New Professional 
Services Group 
Scottsdale, AZ—MasterTax, the leading provider 
of payroll tax software, announced the creation of 
a new group, entitled Professional Services. This 
new Professional Services Group will be aimed 
towards providing MasterTax customers with   
consulting and programming customization     
services on a per diem basis. “While we have 
been providing these types of services to our  
customers, it was not necessarily as organized an 
effort as it could have been,” stated Richard 
Warneka, President of MasterTax. “This new group allows us to better service our customers not 
only from a efficiency standpoint, but also in terms of communication with our customers.          
Customers now will have a dedicated, knowledgeable staff that can provide expertise on creating 
custom projects as well as status updates on existing request projects.” 

“We are very excited to provide this new service to our customers,” said Bill Harris, Director of   
Development. “Our customers have always been a driving force in terms of furthering our grasp as 
the most efficient and full featured payroll tax filing software solution in the marketplace. Their input 
combined with a streamlined Professional Services Group will ensure that our customers will     
continue to have the latest and greatest in technology and features in MasterTax.” 

The Professional Services Group may be reached through MasterTax Customer Support at (480) 
778-8734 or via email at support@mastertax.net. 
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Competitive Upgrade Announced for FLS 
Users 
Scottsdale, AZ - MasterTax, the leading provider of payroll tax software, announced a competitive 
upgrade plan for all users of any FLS product. “With the combination of the uncertainty of continued 
FLS product support due to the purchase of FLS by Best Software, MasterTax’s new features to 
allow a seamless conversion between products, and a special, cost-effective pricing model for all 
FLS users,” stated Richard Warneka, President of MasterTax, “we feel that FLS users have a very 
compelling reason to make the switch to a more full featured, complete, and easy-to-use product.” 

The conversion from FLS to MasterTax has been greatly simplified thanks to the incorporation of a 
data conversion module introduced in the MasterTax 4th Quarter 2004 release. “Ex-FLS users can 
now create a data file out of FLS and import that into MasterTax,” said Mr. Warneka. “Once       
imported, MasterTax will contain all the liabilities entered into FLS. We can also accept the FLS 
formatted daily liability file out of any payroll system. It can’t be any easier.” 

MasterTax has re-instituted a referral program for all MasterTax customers to encourage them to 
refer current FLS users to MasterTax. A Bose Wave radio is given to anyone MasterTax user that 
refers a FLS user that results in a sale.  For more information, please contact the MasterTax Sales 
Group at (480) 778-8705 or via email at emailus@mastertax.net. 



Sherry Hahn is the Payroll Tax Specialist at Ruby Tuesday, Inc. in Maryville, TN.  Sherry 
has been processing taxes with the client/server Enterprise version of MasterTax for the 
past two years.   

MasterNews:  Since you implemented MasterTax, how have your daily tasks changed? 

Sherry Hahn:  Before I answer the question I would like to give you a little back ground 
as to what it was like without MasterTax.   

Before MasterTax everything was manual. We imported once a week, which brought in a 
report that included everything for that week. We had to separate each tax: State, Local, 
Fed etc.  What didn’t need to be paid that week got put in a folder to be paid when it  
became due. We depended on a log sheet to queue us as to what needed to be paid 
and when. When you deal with 23 Franchise’s, 4 Corp. account (Corp. accounts include 
29 states, 80 locals, 35 OPT’s), and 1 Specialty Group, this became very cumbersome.  
When you deal with this many taxes the old way of doing our taxes was tedious and time 
consuming to say the least. 

Since MasterTax, our daily tasks have changed tremendously for the good.  We no 
longer have to rely on our log sheets and enormous folders of weekly imports; Master-
Tax keeps track of when everything is due. We simply go into Deposit Payment and from 
there MasterTax or we select what payments are to be paid for that day.  Whether it is a 
check or EFT Credit payment, MasterTax creates the file, prints the requests and      
coupons. What use to take us all day now takes a couple of hours.�

MN:  What utilities do you use most often in MasterTax? 

SH: On a daily basis I would have to say we use Deposit Maintenance.  After we receive 
either the check or confirmation we then enter the check number and date of the check, 
or if it was an EFT, we would enter the Confirmation number.  We also use this to look 
up detail on deposits, or to see the detail of a pending deposit. 

While doing research or if we need a copy of last years deposit or return, it is a lot easier 
to look them up and print them from Reprint Returns then it is to go and pull last years 
folders. 

MN:  What reports do you use most often in MasterTax?  What information do they help 
you with in your tasks outside of MasterTax? 

SH: The reports that the reconciliation team uses the most are definitely the Liability and 
Deposit Analysis reports.  These reports contain a tremendous amount of useful        
information.  We are able to select an individual company and search specific payment 
for Federal, FICA, State, FUI, SUI, or local taxes.  These reports are used to reconcile 
the general ledger to the payments made. 

Other reports that the reconciling team use are the QTD and YTD Analysis.  These   
reports allow us to once again search by company (or multiples if desired) for all the  
variances made in a quarter or in an entire year.  This report eliminates the need for  
exhaustive research for the amounts that fall between what was actually deducted and 
what was paid.  We can get all of the information we need in one report. 

MN:  What files and/or reports do you generate to communicate with other departments 
in your company?  For EFT and check payments?  For G/L reporting? 

SH: With regard to communicating with other departments in our company, the Liability 
Analysis reports are the most commonly used.  With the pending and deposited feature, 
the user can easily see how this report reconciles with the G/L for the payments and also 
for the deductions in each account.  We have found these reports to be the most concise 
and the easiest to read at a glance for people outside of the MasterTax user. 

We also use the ACH Credit file which is created at the Deposit Payment screen, which 
we then export to a file and send directly to our bank.  The accounts we have set up for 
ACH Credit use to be called in manually by our Cash Management team. By sending this 
file there is less chance for an error and a great time saver for them. 

Please direct all Customer  
and Technical Support             

issues to: 

MasterTax Customer 
Support                       

support@mastertax.net
(480) 778-8734 
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We are looking for people 
to be featured on a future 
User Spotlight! If you are 

interested, please send us 
an email at                                

newsletter@mastertax.net. 

MasterNews User Spotlight: Sherry Hahn 
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The following is a list of updates for select U.S. taxing agencies. For more information 
about these or any other agency changes, please contact MasterTax Customer    
Support. 

·  All Pennsylvania Occupational Privilege Taxes (OPT) have been renamed to 
Emergency and Municipal Services Tax (EMST). 

·  Pittsburgh, PA has instituted a new payroll expense tax, which is reported to its 
own custom form (the tax code in MasterTax is PA2079-143, the custom form will 
be available in the 1st Quarter 2005 release). 

·  New 941 form is now available 

·  Louisiana has instituted a new Social Charge tax, which is combined with the SUI 
rate on the SUI tax form (MasterTax tax code LA0000-148). However, it is not 
eligible for a Tentative Credit for FUTA.  

·  IA SWH reconciliations and coupons can now be filed online. For those that are 
paying by check but are filing online, MasterTax will still create a coupon to be 
sent with the check. The paper coupon and electronic coupon both need to be 
submitted. 

·  New Ohio locals - Octa, West Alexandria, Tontagany, Coal Grove. 

·  New Alabama local - Shorter. 

Agency Updates 

Q. What tax returns and coupons are 
available in MasterTax for online filings? 

Here is the list of tax returns and coupons 
that MasterTax is currently creating online 
files for. MasterTax continually adds to this 
list with every quarter’s release. For step-
by-step instructions on how to submit 
these files to the agencies online, go to 
Tax Returns > E-File > Filing Instructions. 

Al A-1: AL Quarterly W/H 

CT 941 DRS: CT Quarterly W/H 

CT UC-2: CT SUI 

FL UCT-6: FL SUI 

MA M-941D: MA QW W/H 

MA WR-1: MA SUI 

MI UC 1020: MI SUI 

MN MW-6: MN Annual W/H 

MO MODES 4-7: MO SUI 

NC NCUI 101: NC SUI 

ND NDUC-202: ND SUI 

TX C-3: TX SUI 

UT FORM 3: UT SUI 

WA EMS 5208: WA SUI 

FORM 941: Federal W/H (Beta for Q1 
2005) 

IA 44-095: IA Quarterly W/H (Pending 
Approval) 

AL A-6: AL Monthly W/H Return/Coupon 

MA M-941W: MA Weekly W/H Coupon 

IA 44-101: IA W/H Coupon (Pending   
Approval) 

MN MDES: MN SUI Coupon (Q2 2005 
release) 

If you would like further clarification to the 
answer given or have an additional    
question stemming from the information 
above, please submit your inquiry to             
newsletter@mastertax.net. 

MasterNews Question of the Quarter 
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SYNERGY 2006            
ANNOUNCEMENT 

Synergy 2006, the bi-
annual MasterTax User’s 

Conference, will be held on 
March 12–15, 2006. This 
always exciting and infor-
mative event is to be held 

once again in the Phoenix - 
Scottsdale, AZ area,      

although the exact location 
is has yet to be determined. 

Please look for future an-
nouncements regarding the 
exact location and agenda 

items for Synergy 2006. 
We look forward to seeing 

you all there! 

Corporate: 

MasterTax would like to welcome our newest addition to the MasterTax Sales 
Group: Dan Shumate. Dan is our new Regional Sales Manager - Southeast   
Region. Please join us in welcoming him on board with MasterTax! 

Software: 
The following is a preview of new software changes for the 1st  
Quarter 2005 release. Please refer to the upcoming Release Notes 
for further clarification and other unlisted changes. 

·  All MasterTax reports appear Maximized upon completion 

·  New access to screen sensitive Help from any screen 

·  Access to change additional options in Company View > Quick Edit 

·  MasterTax Error Messages list resolutions under 
File>Preferences>Exceptions 

·  Export Company Master Data 

·  Ability to control minimum number of characters of a username 

·  Ability to turn off required special character in Change Password 

The following is a list of pre-release beta items included in the 1st 
Quarter 2005 release. They will be made available for production use 
in a future release. 

·  E-file 941 

·  Automated SUI Rate Exchange with Agencies 

Updates In... 

The following is a list of future enhancements that MasterTax has planned 
for the upcoming quarters: 

·  E-file 941/940 

·  Canadian Payroll Tax Reporting and Payment Module 

·  Bank Reconciliation 

MasterTax is currently seeking customers who are willing to participate in 
the research, design, and test implementation of each new enhancement 
listed above. As with all of our enhancements, customer input is essential 
in creating features that are comprehensive, accurate, and easy-to-use. 
MasterTax would be more than happy to welcome all levels of customer 
participation in these and any other enhancement suggestions. If you 
would like to participate in these enhancements or are looking for more 
information, please contact MasterTax Customer Support at (480) 778-
8734 or via email at support@mastertax.net.  

Coming Soon... 


